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1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which
employs a workflow engine to provide a real-time visual representation of a data reduction cascade, called a
workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex
have been discussed by Freudling et al. (2013A&A...559A..96F). Please reference this article if you use Reflex
in a scientific publication.

Reflex and the data reduction workflows have been developed by ESO and instrument consortia and they are
fully supported. If you have any issue, please contact usd-help@eso.org for further support.

This document is a tutorial designed to enable the user to employ the GRAVITY workflow to reduce his/her
data in a user-friendly way, concentrating on high-level issues such as data reduction quality and signal-to-noise
(S/N) optimisation.

A workflow accepts science and calibration data, as downloaded from the archive using the CalSelector tool1

(with associated raw calibrations) and organises them into DataSets, where each DataSet contains one science
object observation (possibly consisting of several science files) and all associated raw and static calibrations
required for a successful data reduction. The data organisation process is fully automatic, which is a major
time-saving feature provided by the software. The DataSets selected by the user for reduction are fed to the
workflow which executes the relevant pipeline recipes (or stages) in the correct order. Full control of the various
recipe parameters is available within the workflow, and the workflow deals automatically with optional recipe
inputs via built-in conditional branches. Additionally, the workflow stores the reduced final data products in a
logically organised directory structure employing user-configurable file names.

This tutorial deals with the reduction of GRAVITY single and dual mode observations only via the GRAVITY
Reflex workflow. For more detail on the pipeline, the user is referred to the (preliminary) pipeline manual and
the GRAVITY user manual ([2]2) and to the ESO instrument web pages 3 for more information on the instrument
itself as well as a summary of available documentation, recent news, and tools. The cookbook aspects derive
from further guidance on GRAVITY data reduction and analysis in general.

The quick start section (see Section 5) describes the minimum effort to get started, and it makes up only two
pages of text in this tutorial. User support for this software is available by sending enquiries to usd-help@eso.org.

1http://www.eso.org/sci/archive/calselectorInfo.html
2available at: http://www.eso.org/sci/facilities/paranal/instruments/gravity/doc
3http://www.eso.org/sci/facilities/paranal/instruments/gravity.html

mailto:usd-help@eso.org
http://www.eso.org/sci/archive/calselectorInfo.html
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2 Workflow Status

The GRAVITY Reflex workflow, in its current version, is preliminary but is capable, together with its underlying
GRAVITY pipeline, of delivering calibrated data products. The Reflex workflows are built upon the GRAVITY
pipeline delivered by LESIA, Observatoire de Paris.

The first step of the GRAVITY Reflex workflow is to organise the data of this instrument into an associated,
organised, and classified structure including for each science or interferometric calibrator file the required in-
strument calibration files with matching spectral resolution and integration time. The user will be warned if any
calibration frames are missing.

The GRAVITY Reflex workflow, gravity_wkf, will correct the frames for their dark level and structure, flat-field
the data, and compute a wavelength solution, A large number of data products are created and retained for the
user to assess the quality of the pipeline processing.

An alternative workflow, gravity_mastercalib, allows to reduce data with the P2VM master calibration file which
can be downloaded from the archive. This allows the user to skip the resource-intensive P2VM computation
step (you would need at least 8GB of RAM in high resolution mode).

Calibrating the science observations is done with a separate workflow, gravity_viscal.

During the processing within the Reflex workflow, the user has the ability to modify a number of pipeline
parameters in order to optimise the data processing.

During the pipeline development and the experience of GRAVITY use, the pipeline parameters have been set to
default values that deliver the best results for the most cases. However, the user should make an effort to adjust
and experiment with the parameters to optimize the results.
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3 Software Installation

Reflex and the workflows can be installed in different ways: via package repositories, via the
install_esoreflex script or manually installing the software tar files.

The recommended way is to use the package repositories if your operating system is supported. The macports
repositories support OS X, while the rpm/yum repositories support Fedora 20 to 25. For any other operating
system it is recommended to use the install_esoreflex script.

3.1 Installing Reflex workflows via macports

This method is supported for the OS X operating system. It is assumed that macports
(http://www.macports.org) and java are installed. If you have any problem with this installation method, please
read the full documentation at
http://www.eso.org/sci/software/pipelines/installation/macports.html.

For a quick installation, the following steps will install the ESO pipeline macports repository, the GRAVITY
pipeline, including the Reflex workflow support and Reflex itself:

• Set up the repository:

# curl ftp://ftp.eso.org/pub/dfs/pipelines/repositories/macports/setup/Portfile -o Portfile
# sudo port install
# sudo port sync

• Install the GRAVITY pipeline:
# sudo port install esopipe-gravity-all

3.2 Installing Reflex workflows via rpm/yum

This method is supported for Fedora 20/21/22/23/24/25 operating systems. If you have any problem with this
installation method, please read the full documentation at
http://www.eso.org/sci/software/pipelines/installation/rpm.html.

For a quick installation, the following steps will install the ESO pipeline rpm repository, the GRAVITY pipeline,
including the Reflex workflow support and Reflex itself:

• Set up the repository for Fedora 20/21:

# sudo yum install yum-utils
# sudo yum-config-manager \

--add-repo=ftp://ftp.eso.org/pub/dfs/pipelines/repositories/fedora/esorepo.repo

• Set up the repository for Fedora 22/23/24/25:

# sudo dnf install dnf-plugins-core
# sudo dnf config-manager \

--add-repo=ftp://ftp.eso.org/pub/dfs/pipelines/repositories/fedora/esorepo.repo

http://www.macports.org
http://www.eso.org/sci/software/pipelines/installation/macports.html
http://www.eso.org/sci/software/pipelines/installation/rpm.html
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• Install the GRAVITY pipeline (Fedora 20/21):
# sudo yum install esopipe-gravity-all

• Install the GRAVITY pipeline (Fedora 22/23/24/25):
# sudo dnf install esopipe-gravity-all

3.3 Installing Reflex workflows via install_esoreflex

The software pre-requisites for Reflex 2.9 may be found at:
http://www.eso.org/sci/software/pipelines/reflex_workflows

To install the Reflex 2.9 software and demo data, please follow these instructions:

1. From any directory, download the installation script:

wget ftp://ftp.eso.org/pub/dfs/reflex/install_esoreflex

2. Make the installation script executable:

chmod u+x install_esoreflex

3. Execute the installation script:

./install_esoreflex

and the script will ask you to specify three directories: the download directory <download_dir>, the
software installation directory <install_dir>, and the directory to be used to store the demo data
<data_dir>. If you do not specify these directories, then the installation script will create them in the
current directory with default names.

4. You will be asked whether you want to use your Internet connection. Unless you want to reuse already
downloaded packages (only advanced users), use the default Yes.

5. You will be given a choice of pipelines (with the corresponding workflows) to install. Please specify the
numbers for the pipelines you require, separated by a space, or type “A” for all pipelines.

6. For the pipelines to be installed you will be prompted for the demo data sets to be installed. Type “A” for
all demo datasets. Take into account that if you are installing in a directory that already contains data, it
won’t be removed.

7. The script will also detect whether previous versions of the workflows or Reflex were installed and in this
case you have the option to update links or remove obsolete cache directories. It is advised to use the
defaults.

8. If some of the prerequisite binaries for Reflex are not under one of the paths indicated by the command,

http://www.eso.org/sci/software/pipelines/reflex_workflows
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getconf PATH

then you will need to add the appropriate paths as a colon separated list to the esoreflex.path
parameter in the configuration file <install_dir>/etc/esoreflex.rc. This will usually be
necessary when the FITS viewer (fv) is installed outside of /usr/bin. As an example, assume fv is
installed into the directory /usr/local/fv5.4, the file esoreflex.rc should then have the line
setting esoreflex.path look similar to the following:

esoreflex.path=/usr/local/fv5.4

In the case of OS X /Applications/fv.app/Contents/MacOS/ is the typically installation
directory. Thus, this should be similar to the following line instead:

esoreflex.path=/opt/local/bin:/Applications/fv.app/Contents/MacOS

9. To start Reflex, issue the command:

<install_dir>/bin/esoreflex

It may also be desirable to set up an alias command for starting the Reflex software, using the shell com-
mand alias. Alternatively, the PATH variable can be updated to contain the <install_dir>/bin
directory.
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4 Demo Data

Together with the pipeline you can also choose to receive a demo data set that allows you to run the Reflex
GRAVITY workflow without any changes in parameters. This way you have data sets to experiment with before
you start to work on your own data.

Note that you will need a minimum of ∼5 GB, ∼9 GB and ∼8 GB of free disk space for the directories
<download_dir>, <install_dir> and <data_dir>, respectively.

The raw input consists of OBJ-SKY-OBJ-SKY sequences of:

1. two calibrator OBs of HIP 64314, and

2. one science OB of a double star, HD 114529 (ρ = 143.0 mas, θ = 132.6◦, secondary flux fraction =
24%).

The data set also includes the DARK, P2VM, FLAT, WAVE, and WAVESC files. The raw tutorial data sets
are summarized in Table 4.1. The list of files as shown in the table can be obtained by executing the following
command (part of the ESO SciSoft collection) in the demo data directory:
dfits *.fits | fitsort obs.name dpr.catg dpr.type tpl.expno
ins.filt1.name ins.filt2.name dit
FILT1 refers to the Wollaston prism, which is “IN” when recording both polarizations and “OUT” when record-
ing the sum of both signals. FILT2 refers to the spectral resolution. Note the two DARK frames with different
DIT, one belonging to the science frames, the other one to the P2VM frames.
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Table 4.1: The GRAVITY Reflex workflow tutorial data set, single field mode data with medium spectral
resolution and no polarization.

File OBS.NAME DPR.CATG DPR.TYPE EXPNO FILT1.NAME FILT2.NAME DIT
GRAVI.2016-06-22T16:26:14.536.fits Calibration CALIB DARK 1 OUT MED 0.3
GRAVI.2016-06-22T16:27:29.540.fits Calibration CALIB FLAT 2 OUT MED 0.3
GRAVI.2016-06-22T16:28:05.542.fits Calibration CALIB FLAT 3 OUT MED 0.3
GRAVI.2016-06-22T16:28:41.544.fits Calibration CALIB FLAT 4 OUT MED 0.3
GRAVI.2016-06-22T16:29:17.546.fits Calibration CALIB FLAT 5 OUT MED 0.3
GRAVI.2016-06-22T16:30:02.549.fits Calibration CALIB WAVE,SC 6 OUT MED 0.3
GRAVI.2016-06-22T16:35:38.568.fits Calibration CALIB WAVE 7 OUT MED 0.3
GRAVI.2016-06-22T16:40:23.583.fits Calibration CALIB P2VM 8 OUT MED 0.3
GRAVI.2016-06-22T16:42:59.592.fits Calibration CALIB P2VM 9 OUT MED 0.3
GRAVI.2016-06-22T16:45:35.601.fits Calibration CALIB P2VM 10 OUT MED 0.3
GRAVI.2016-06-22T16:48:11.610.fits Calibration CALIB P2VM 11 OUT MED 0.3
GRAVI.2016-06-22T16:50:47.619.fits Calibration CALIB P2VM 12 OUT MED 0.3
GRAVI.2016-06-22T16:53:23.628.fits Calibration CALIB P2VM 13 OUT MED 0.3
GRAVI.2016-06-22T17:11:47.690.fits Calibration CALIB DARK 1 OUT MED 10.0
GRAVI.2016-06-23T00:19:55.884.fits CAL_HIP64314 CALIB OBJECT,SINGLE 1 OUT MED 10.0
GRAVI.2016-06-23T00:24:37.900.fits CAL_HIP64314 CALIB SKY,SINGLE 2 OUT MED 10.0
GRAVI.2016-06-23T00:29:22.916.fits CAL_HIP64314 CALIB OBJECT,SINGLE 3 OUT MED 10.0
GRAVI.2016-06-23T00:34:04.932.fits CAL_HIP64314 CALIB SKY,SINGLE 4 OUT MED 10.0
GRAVI.2016-06-23T00:47:52.978.fits SCI_HD114529 SCIENCE OBJECT,SINGLE 1 OUT MED 10.0
GRAVI.2016-06-23T00:52:34.994.fits SCI_HD114529 SCIENCE SKY,SINGLE 2 OUT MED 10.0
GRAVI.2016-06-23T00:57:20.010.fits SCI_HD114529 SCIENCE OBJECT,SINGLE 3 OUT MED 10.0
GRAVI.2016-06-23T01:02:02.026.fits SCI_HD114529 SCIENCE SKY,SINGLE 4 OUT MED 10.0
GRAVI.2016-06-23T01:17:05.077.fits CAL_HIP64314 CALIB OBJECT,SINGLE 1 OUT MED 10.0
GRAVI.2016-06-23T01:21:47.092.fits CAL_HIP64314 CALIB SKY,SINGLE 2 OUT MED 10.0
GRAVI.2016-06-23T01:26:35.108.fits CAL_HIP64314 CALIB OBJECT,SINGLE 3 OUT MED 10.0
GRAVI.2016-06-23T01:31:20.125.fits CAL_HIP64314 CALIB SKY,SINGLE 4 OUT MED 10.0
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5 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe
the steps to be performed to reduce the science data provided in the GRAVITY demo data set supplied with
the Reflex 2.9 release. By following these steps, the user should have enough information to perform a
reduction of his/her own data without any further reading:

Figure 5.1: The empty Reflex canvas.

1. Start the Reflex application:

esoreflex &

If install_esoreflex was used or manual installation was performed then the start command is:

<install_dir>/bin/esoreflex &

The empty Reflex canvas as shown in Figure 5.1 will appear.

2. Now open the GRAVITY workflow by clicking on File -> Open File, selecting first
gravity-1.2.1 and then the file gravity_wkf.xml in the file browser. You will be presented
with the workflow canvas shown in Figure 8.1. Note that the workflow will appear as a canvas in a new
window.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlight-
ing. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the
animation interval (100 ms is recommended), and click OK .

4. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important di-
rectories (green dots). Changing the value of ROOT_DATA_DIR and/or RAW_DATA_DIR is the only
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necessary modification if you want to process data other than the demo data4, since the value of this pa-
rameter specifies the working directory within which the other directories are organised. Double-click on
the parameter ROOT_DATA_DIR and a pop-up window will appear allowing you to modify the directory
string, which you may either edit directly, or use the Browse button to select the directory from a file
browser. When you have finished, click OK to save your changes.

5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data di-
rectory (specified by the parameter RAW_DATA_DIR under “Setup Directories” in the workflow can-
vas) and constructs the DataSets. Note that the raw and static calibration data must be present either
in RAW_DATA_DIR or in CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be
processed. However, if the same reference file was downloaded twice to different places this creates a
problem as Reflex cannot decide which one to use.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window
(see Figure 8.4) that lists the DataSets along with the values of a selection of useful header keywords5.
The first column consists of a set of tick boxes which allow the user to select the DataSets to be processed.
By default all complete DataSets which have not yet been reduced will be selected.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting
of the actors. A window will show which DataSet is currently being processed.

9. Once the reduction of all DataSets has finished, a pop-up window called Product Explorer will appear,
showing the datasets which have been reduced together with the list of final products. This actor allows
the user to inspect the final data products, as well as to search and inspect the input data used to create
any of the products of the workflow. Figure 8.5 shows the Product Explorer window.

10. After the workflow has finished, all the products from all the DataSets can be found in a directory under
END_PRODUCTS_DIR with the named with the workflow start timestamp. Further subdirectories will
be found with the name of each DataSet.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge
to reduce your own data. However, there are many interesting features of Reflex and the GRAVITY workflow
that merit a look at the rest of this tutorial.

4If you used the install script install_esoreflex, then the value of the parameter ROOT_DATA_DIR will already be set
correctly to the directory where the demo data was downloaded.

5The keywords listed can be changed by right-clicking on the DataOrganiser Actor, selecting Configure Actor, and then
changing the list of keywords in the second line of the pop-up window.
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6 About The Reflex Canvas

6.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even
if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you
modify a workflow in any way, you have the option of saving the modified version to an XML file using File
-> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved
workflow may be opened in subsequent Reflex sessions using File -> Open. Saving the workflow in the
default Kepler format (.kar) is only advised if you do not plan to use the workflow with another computer.

6.2 Buttons

At the top of the Reflex canvas are a set of buttons which have the following functions:

• - Zoom in.

• - Reset the zoom to 100%.

• - Zoom the workflow to fit the current window size (Recommended).

• - Zoom out.

• - Run (or resume) the workflow.

• - Pause the workflow execution.

• - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

6.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the

yellow highlighting of the , , and buttons, respectively. A workflow is executed by clicking the
button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the

button, or the workflow may be paused by clicking the button which will allow the current actor/recipe
to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by

clicking the button again.
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7 The GRAVITY Workflow

The GRAVITY workflow canvas is organised into a number of areas. From top-left to top-right you will find
general workflow instructions, directory parameters, and global parameters. In the middle row you will find five
boxes describing the workflow general processing steps in order from left to right, and below this the workflow
actors themselves are organised following the workflow general steps.

7.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directo-
ries” the user is only required to set the RAW_DATA_DIR to the working directory for the DataSet(s) to be
reduced, which, by default, is set to the directory containing the demo data. The RAW_DATA_DIR is recur-
sively scanned by the Data Organiser actor for input raw data. The directory CALIB_DATA_DIR, which
is by default within the pipeline installation directory, is also scanned by the Data Organiser actor to find
any static calibrations that may be missing in your DataSet(s). If required, the user may edit the directories
BOOKKEEPING_DIR, LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond
to the directories where book-keeping files, logs, temporary products and end products are stored, respectively
(see the Reflex User Manual for further details; [3]).

There is a mode of the Data Organiser that skips the built-in data organisation and uses instead the data or-
ganisation provided by the CalSelector tool. To use this mode, click on Use CalSelector associations
in the Data Organiser properties and make sure that the input data directory contains the XML file down-
loaded with the CalSelector archive request.

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to
the command used for running his/her favourite application for inspecting FITS files. Currently this is set by
default to fv, but other applications, such as ds9, skycat and gaia for example, may be useful for inspecting
image data. Note that it is recommended to specify the full path to the visualization application (an alias will
not work).

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before
executing the workflow, and the recipe actors will work in Lazy Mode (see Section 7.2.3), reusing the previous
pipeline recipe outputs where input files and parameters are the same as for the previous execution, which saves
considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to true, which
forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR,
LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will
force the workflow to fully re-reduce the data each time the workflow is run.

The parameter RecipeFailureMode controls the behaviour in case that a recipe fails. If set to Continue,
the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most
of the cases will lead to further failures of other recipes without the user actually being aware of it. This mode
might be useful for unattended processing of large number of datasets. If set to Ask, a pop-up window will ask
whether the workflow should stop or continue. This is the default. Alternatively, the Stop mode will stop the
workflow execution immediately.

The parameter GlobalPlotInteractivity controls whether the interactive windows will appear for those
windows which are enabled by default. The possible values are true, false. Take into account that some
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windows are disabled in the default configuration and therefore are not affected by this parameter.

The parameter ProductExplorerMode controls whether the ProductExplorer actor will show its win-
dow or not. The possible values are Enabled, Disabled and Triggered. The latter, recommended, means
that the ProductExplorer actor will be shown only at the end of the workflow execution.

7.2 Workflow Actors

7.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They
may also have an icon within the rectangle to aid in their identification. The following actors are simple actors:

• - The Data Organiser actor.

• - The Data Set Chooser actor (inside a composite actor).

• - The Fits Router actor

• - The Product Renamer actor.

• - The Product Explorer actor (inside a composite actor).

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting Configure
Actor. This will open an “Edit parameters” window. Note that the Product Renamer actor is a jython
script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking
on it).

7.2.2 GRAVITY-specific actors: the workflow data-reduction cascade

The present GRAVITY workflow is designed to process the datasets according to a specific data reduction
cascade. This cascade triggers a series of pipeline recipes, which are associated to the following composite
actors:

• GravityDark: it executes the recipe gravity_dark . It processes the dark frames to create
a master dark needed both for the recipe gravity_p2vm and for gravity_vis. The master dark frames need
to have the same DIT as the corresponding science/calibration frames.
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• GravityP2VM: it executes the recipe gravity_p2vm. It requires products of gravity_dark
as input, as well as raw P2VM, FLAT, and WAVE files.

• GravityScience: it executes the recipe gravity_vis. It requires products of gravity_dark
as input, as well as reduced BAD, P2VM, FLAT, and WAVE files.

• Visibilities Calibration: it executes the recipe gravity_viscal. It requires prod-
ucts of gravity_vis as input, for a science target and one or more calibrator observations.

This is an interactive actor, meaning that an apposite interacting window will appear allowing the used to
inspected the products and, eventually, to re-run the recipe with modified parameters.

We refer the user to the GRAVITY pipeline manual for a complete description of the recipes and their parame-
ters.

As noted in the Quick Start Section 5, the workflow will then proceed through its remaining processing steps and
write out all pipeline products to the end products directory (specified by the parameter END_PRODUCTS_DIR
under “Setup Directories” in the workflow canvas). The science data products from the tutorial data set are sum-
marized in section 10 in table 10.2. The intermediate pipeline calibration products can be found in subdirectories
of the TMP_PRODUCT_DIR and are summarized in section 10 and in table 10.

7.2.3 Lazy Mode

By default, all recipe executer actors in a pipeline workflow are “Lazy Mode” enabled. This means that when
the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has
already been executed with the same input files and with the same recipe parameters. If this is the case, then the
actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products
to the output port. The purpose of the Lazy Mode is therefore to minimise any reprocessing of data by avoiding
data re-reduction where it is not necessary.

One should note that the actor’s Lazy Mode depends on the contents of the directory specified by the parameter
BOOKKEEPING_DIR and the relevant FITS file checksums. Any modification to the directory contents and/or
the file checksums will cause the corresponding actor to run the pipeline recipe again when executed, thereby
re-reducing the input data.

The re-reduction of data at each execution may sometimes be desirable. To force a re-reduction of data for
any single RecipeExecuter actor in the workflow, right-click the actor, select Configure Actor, and
uncheck the Lazy mode parameter tick-box in the “Edit parameters” window that is displayed. For many work-
flows the RecipeExecuter actors are actually found inside the composite actors in the top level workflow.
To access such embedded RecipeExecuter actors you will first need to open the sub-workflow by right-
clicking on the composite actor and then selecting Open Actor.
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To force the re-reduction of all data in a workflow (i.e. to disable Lazy mode for the whole workflow), you must
uncheck the Lazy mode for every single RecipeExecuter actor in the entire workflow. It is also possible to
change the name of the bookkeeping directory, instead of modifying any of the Lazy mode parameters. This will
also force a re-reduction of the given dataset(s). A new reduction will start (with the lazy mode still enabled),
but the results of previous reduction will not be reused. Alternatively, if there is no need to keep any of the
previously reduced data, one can simply set the EraseDirs parameter under the “Global Parameters” area of
the workflow canvas to true. This will then remove all previous results that are stored in the bookkeeping,
temporary, and log directories before processing the input data. In effect, starting a new clean data reduction
and re-processing every input dataset.



ESO Reflex GRAVITY Tutorial and
Coobook

Doc: VLT-MAN-ESO-19500-....
Issue: Issue 1.2.1
Date: Date 2018-11-01
Page: 21 of 43

8 Reducing and Calibrating Your Own Science Data with Reflex

8.1 Available Reflex workflows

There are two workflows available for the reduction and one workflow for the calibration of the visibility data.
While the workflow gravity_wkf shown in Fig. 8.1 performs all reduction steps using the raw data, the workflow
gravity_mastercalib shown in Fig. 8.2 uses the P2VM master calibration files downloaded from the ESO archive
(asscociated processed calibrations), allowing you to bypass the resource-heavy step of the P2VM computation.
The workflow gravity_viscal in Fig. 8.3 calibrates the reduced science files.

Figure 8.1: gravity_wkf workflow layout.
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Figure 8.2: gravity_mastercalib workflow layout.
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Figure 8.3: gravity_viscal workflow layout.
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8.2 Specifying data directories

To reduce your own science data, simply change the paths to the root (optional) and data directories. Under
the former, Reflex will create sub-directories which will contain temporary and end products, as well as book
keeping and log files. The latter, normally also under the root directory, contains directories with your raw files
downloaded from the ESO archive. The paths are defined at the top of the workflow window in the area labeled
Setup Directories. Simply double click on the RAWDATA_DIR, enter the path to your raw science
directory and then re-run the workflow in the same way as you did for the tutorial demo data. In case the data
sets listed in the first window created by the work flow (Fig. 8.4) are greyed out, calibration files are missing
(hovering with the mouse over the grey file entry will give more details). You can click the entry and a GUI
opens up showing the dependency tree of the science (or calibrator) file on calibrations (Fig. 8.4). Please note
that the pipeline step which computes the P2VM calibration file requires about 8 GB of memory for the demo
data (medium resolution, no polarization), about 12 GB for high resolution (no polarization), and up to about
20 GB for high resolution with polarization.
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Figure 8.4: Upper panel: the “Select Datasets” pop-up window; Lower panel: the “Select Frame” pop-up
window, obtained after pressing the “Inspect highlighted” button in the “Select Datasets” window.
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When the workflow has finished, the Product Explorer window opens (Fig. 8.5). Select a data file and unfold the
file tree in the “Provenance Tree” window. This provides information on the dependency of product files on the
calibration files and other files from recipes executed before. You can inspect a data file by clicking the “Inspect
with...” button, and entering the path to your favourite FITS file viewer (e.g., fv). Examples of the master flat
frame (Fig. 8.6) and a master dark frame (Fig. 8.7) are shown below.

Figure 8.5: The GRAVITY product explorer.
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Figure 8.6: GRAVITY master flat image, stored in the IMAGING_DATA_SC binary extension. The horizontal
axis is the wavelength axis, the 24 output channels are arranged along the vertical axis.

Figure 8.7: GRAVITY master dark image, stored in the IMAGING_DATA_SC binary extension. The horizontal
axis is the wavelength axis, the 24 output channels are arranged along the vertical axis.
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8.3 Calibrating your visibility data

The workflow gravity_viscal allows you to select (aside from the science file) one or more calibrator files which
will define the transfer function (TF, i.e., the visibility measured on a calibrator, corrected for the effect of a
non-zero diameter of the calibrator). The demo data set includes two calibrators, one measured before and one
after the science target. Thus, the TF will be linearly interpolated to the epoch of the science observations.
When running this recipe, you will be presented with a (not yet interactive) plot window showing the TF for
each of the six baselines of GRAVITY, as shown in Fig. 8.8. The calibrator diameter information is taken from
file GRAVI_FAINT_CALIBRATORS.fits in the Reflex installation directory install/calib/gravity-1.0.0/cal.

Figure 8.8: gravity_viscal workflow plot of the FT and SC channel transfer functions.
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9 Optimising Your Results Through Workflow Interaction

In this Section, we use the information from Section 5 along with the GRAVITY demo data set supplied with
pipeline version 1.2.1 to illustrate how to optimise the scientific products in terms of quality and signal-to-noise
ratio.

This is work in progress and the contents of this section will grow as we gain experience and add functionality.
Optimising the results is achieved by interaction with the workflow actors via interactive windows displayed
at key data reduction points in the data flow, which enable iteration of certain recipes in order to obtain better
results.

We recommend that the user has already carried out the reductions for the demo data set as described in Sec-
tion 5, although this is not a pre-requisite to following this section. By doing this, the user will be taking
advantage of the workflow Lazy Mode, with minimal waiting time between various pipeline recipe executions.

As discussed previously, the first operation the GRAVITY workflow does is to group the raw data (science, raw
calibrations, and static calibrations) into datasets to be reduced. The datasets will be then processed in series.

The second operation is to direct all the files of a dataset to the correct pipeline recipe, so that the data reduction
could start and the various recipes can be triggered in the correct order with the correct set of input files. The
data reduction cascade operated by the GRAVITY workflow triggers the recipes according to the data reduction
cascade outlined in Section 7.2.2.

9.1 Bias and vFactor correction of visibilities

The visibility amplitudes are affected by bias and coherence time. The former is related to photon noise and
needs to be subtracted from the (square) modulus of the complex visibility, the latter can be corrected by mul-
tiplying the visibility with a factor larger than 1, called vFactor, which is derived from the GRAVITY fringe
tracker phase RMS.

In version 1.2.1 of the pipeline, the vFactor correction sometimes results in visibilities significantly larger than
unity and therefore must be switched off in those cases. To do this, right-click with the mouse on the Grav-
ityScience actor and select "Open actor". The workflow canvas of this actor will be displayed, and here you
right-click on the gravity_vis actor to select "Configure actor". This will display a window like the one shown
in Fig. 9.1. To disable the vFactor correction, change the value of vis-correction (recipe_param_8) from VFAC-
TOR to NONE.

Likewise, if you needed to disable the bias correction, you would set the value of parameter debias-sc (recipe_param_13)
to "false". However, please note that the bias correction is a fundamental and well established correction which
should only be disabled if you have very good evidence for it not to work in your specific case.

.
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Figure 9.1: The interactive window to edit parameters of recipe gravity_vis.
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10 GRAVITY Reduced Data Description

A number of intermediate pipeline products from the tutorial data set can be found in subdirectories of the
TMP_PRODUCT_DIR. These master calibration files are summarized in Table 10.

Table 10.1: The GRAVITY Reflex workflow tutorial data set: calibration products
File PRO.CATG Description
gravity_p2vm:
GRAVI.2016-06-22T16:26:14.536_dark_bad.fits BAD bad pixel map
GRAVI.2016-06-22T16:27:29.540_flat.fits FLAT flat field
GRAVI.2016-06-22T16:35:38.568_wave.fits WAVE wavelength calibration
GRAVI.2016-06-22T16:40:23.583_p2vm.fits P2VM p2vm

gravity_dark:
GRAVI.2016-06-22T16:26:14.536_dark.fits DARK dark frame

The final products of the reduction pipeline can be found in the directory END_PRODUCT_DIR that is defined
in the “Setup Directories” section at the top of the workflow.

The science data products from the two tutorial data sets are summarized in tables 10.2. Their description will
be done in Section 10.1.

Table 10.2: The GRAVITY Reflex workflow tutorial data set: uncalibrated visibility products
File PRO.CATG Description
GRAVI.2016-06-22T23:07:43.639/CAL_HIP64314_SKY.fits SKY sky frame
GRAVI.2016-06-22T23:07:43.639/CAL_HIP64314_SINGLE_CAL_VIS.fits SINGLE_CAL_VIS uncalibrated averaged visibility data
GRAVI.2016-06-22T23:35:46.735/CAL_HIP64314_SKY.fits SKY sky frame
GRAVI.2016-06-22T23:35:46.735/CAL_HIP64314_SINGLE_CAL_VIS.fits SINGLE_CAL_VIS uncalibrated averaged visibility data
GRAVI.2016-06-22T23:52:43.791/SCI_HD114529_SKY.fits SKY sky frame
GRAVI.2016-06-22T23:52:43.791/SCI_HD114529_SINGLE_SCI_VIS.fits SINGLE_SCI_VIS uncalibrated averaged visibility data
GRAVI.2016-06-23T00:19:55.884/CAL_HIP64314_SKY.fits SKY sky frame
GRAVI.2016-06-23T00:19:55.884/CAL_HIP64314_SINGLE_CAL_VIS.fits SINGLE_CAL_VIS uncalibrated averaged visibility data
GRAVI.2016-06-23T00:47:52.978/SCI_HD114529_SKY.fits SKY sky frame
GRAVI.2016-06-23T00:47:52.978/SCI_HD114529_SINGLE_SCI_VIS.fits SINGLE_SCI_VIS uncalibrated averaged visibility data
GRAVI.2016-06-23T01:17:05.077/CAL_HIP64314_SKY.fits SKY sky frame
GRAVI.2016-06-23T01:17:05.077/CAL_HIP64314_SINGLE_CAL_VIS.fits SINGLE_CAL_VIS uncalibrated averaged visibility data

Table 10.3: The GRAVITY Reflex workflow tutorial data set: calibrated visibility of the science target
File PRO.CATG Description
gravity_viscal:
CAL_HIP64314_SINGLE_CAL_TF_1.fits SINGLE_CAL_TF Transfer function of calibrator
CAL_HIP64314_SINGLE_CAL_TF.fits SINGLE_CAL_TF Transfer function of calibrator
CAL_HIP64314_ZP_CAL.fits ZP_CAL Zero-point calibration (photometry)
SCI_HD114529_SINGLE_SCI_TF.fits SINGLE_SCI_TF Transfer function interpolated for science target
SCI_HD114529_SINGLE_VIS_CALIBRATED.fits SINGLE_SCI_VIS_CALIBRATED calibrated science visibility

10.1 Description of final products

In this section we provide a very brief description of the workflow science products that are stored in the
reflex_end_products directory. They are produced by the pipeline recipes gravity_vis. For further infor-
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mation, please consult the GRAVITY pipeline manual. In the list, the products are identified by their PRO.CATG
keyword.

• SINGLE_CAL_VIS. Product of the recipe gravity_vis for a CAL observation. This file should conform to
the OIFITS2 file format used for interferometric data [1]. If the visibilities of the calibrator are corrected
for the non-zero diameter of the calibrator star, the resulting visibility amplitudes are called the transfer
function (TF).

• SINGLE_SCI_VIS. Product of the recipe gravity_vis for a SCI observation. This file should conform
to the OIFITS2 file format used for interferometric data [1]. The visibility data are averaged, but not
calibrated.

• SINGLE_SCI_VIS_CALIBRATED. Product of the recipe gravity_viscal for a SCI observation. This
file should conform to the OIFITS2 file format used for interferometric data [1]. The visibility data are
averaged and were calibrated by dividing the science target visibilities by the calibrator transfer function
interpolated for the epoch of the science observation. Fig. 10.1 shows the structure of an OIFITS2 file and
Figs. 10.2 and 10.3 show the extenstion table for the (squared) visibility amplitudes and a plot for one of
the baselines.

Figure 10.1: Main structure of OIFITS2 file with binary extension tables.
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Figure 10.2: OIVIS2 table.

Figure 10.3: Plot of the squared visiblity amplitude for baseline 6.
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Figure 10.4: OIFitsExplorer view of the demo data (all science files combined).

One can use the OIFitsExplorer (Fig. 10.4)
(http://www.jmmc.fr/oifitsexplorer_page.htm) to examine the data and LitPro
(http://www.jmmc.fr/litpro_page.htm) to fit simple models.
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11 Reducing Your Own Science Data with Python tools

The GRAVITY consortium developed a set of Python scripts which interface with pipeline recipes to reduce
and analyze data. These tools are not maintained by ESO and no support is provided by ESO. The scripts
can be downloaded from http://version-lesia.obspm.fr/repos/DRS_gravity/python_tools/ or with the following
command:

svn co https://version-lesia.obspm.fr:/repos/DRS_gravity/python_tools

The scripts will be located in a local directory name python_tools. Please consult the README file in that
directory for instructions on how to change the PATH environment variable so that the scripts can be found by
python.

To reduce all demo data at once, change the working directory to the data_wkf/reflex_input/gravity/gravity-
demo-reflex-0.5 created when you downloaded the data. Since the science and calibration data files are located
in verious sub-directories, create symbolic links to them in the working with the following comand (include the
“dot” at the end!):

ln -s */*.fits .

Then run the following command to reduce all files and store the results in a local directory named reduced:

python run_gravi_reduce.py

The following command, if run in the reduced files directory, produces very informative PDF files on the (uncal-
ibrated) results. The same command, when run in reflex_tmp_products/gravity/gravity_p2vm_1 (then choosing
the sub-directory with the date/time stamp corresponding to the desired execution of the work flow), produces a
PDF file with various plots useful for quality control of the P2VM (see the first page in Fig. 11.1).

python run_gravi_visual.py

A useful script is also quicklook.py (http://github.com/amerand/GRAVIQL) which plots visibilities, phases, and
fluxes for reeduced data files.

Finally, the following command calibrates the visibilities of the science targets:

python run_gravi_trend.py

It creates two directories, trends and calibrated. Files GRAVI.????-??-??T??:??:??.???_*_singlesciviscalibrated.fits
contain the calibrated visibilities of the science targets. Alternatively, the reduced data can be calibrated using
the Reflex it gravity_viscal workflow.

http://version-lesia.obspm.fr/repos/DRS_gravity/python_tools/
http://github.com/amerand/GRAVIQL
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Figure 11.1: The first page of the P2VM report produced by run_gravi_visual.py. Note the overall quality
rating box near the top of the page.
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12 Frequently Asked Questions

• The error window fills the whole screen - how can I get to the Continue / Stop buttons?

Press the Alt key together with your left mouse button to move the window upwards and to the left. At
the bottom the Continue / Stop buttons will be visible. This bug is known but could not yet be fixed.

• I tried to Open (or Configure) an Actor while the workflow is running and now it does not react
any more. What should I do?
This is a limitation of the underlying Kepler engine. The only way out is to kill the workflow externally.
If you want to change anything while a workflow is running you first need to pause it.

• After a successful reduction of a data set, I changed this data set in some way (e.g. modified or
removed some files, or changed the rules of the Data Organizer). When I restart Reflex, the Data
Set Chooser correctly displays my new data set, but marks it as “reduced ok”, even though it was
never reduced before. What does this mean?
The labels in the column “Reduced” of the Data Set Chooser mark each dataset with “OK”, “Failed” or
“-”. These labels indicate whether a data set has previously successfully been reduced at least once, all
previous reductions failed, or a reduction has never been tried respectively. Data sets are identified by
their name, which is derived from the first science file within the data set. As long as the data set name is
preserved (i.e. the first science file in a data set has not changed), the Data Organizer will consider it to
be the same data set. The Data Organizer recognizes any previous reductions of data sets it considers to
be the same as the current one, and labels the current data set with “OK” if any of them was successful,
even if the previously reduced data set differs from the current one.

Note that the Product Explorer will list all the previous reductions of a particular data set only at the
end of the reduction. This list might include successful and/or unsuccessful reduction runs with different
parameters, or in your case with different input files. The important fact is that these are all reductions
of data sets with the same first raw science file. By browsing through all reductions of a particular raw
science file, the users can choose the one they want to use.

• Where are my intermediate pipeline products? Intermediate pipeline products are stored in the direc-
tory <TMP_PRODUCTS_DIR> (defined on the workflow canvas, under Setup Directories) and organised
further in directories by pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact this
is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to it
([3]). It is this purpose that is used by the workflow to send the correct set of bias frames to the recipes
for flat frame combination and science frame reduction, which may or may not be the same set of bias
frames in each case.

• Can I run Reflex from the command line? Yes, use the command:

esoreflex -n <workflow_path>/<workflow>.xml

The -n option will set all the different options for Kepler and the workflows to avoid opening any GUI
elements (including pipeline interactive windows).

It is possible to specify workflow variables (those that appear in the workflow canvas) in the command
line. For instance, the raw data directory can be set with this command:
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esoreflex -n -RAW_DATA_DIR <raw_data_path> \
<workflow_path>/<workflow>.xml

You can see all the command line options with the command esoreflex -h.

Note that this mode is not fully supported, and the user should be aware that the path to the workflow must
be absolute and even if no GUI elements are shown, it still requires a connection to the window manager.

• How can I add new actors to an existing workflow? You can drag and drop the actors in the menu
on the left of the Reflex canvas. Under Eso-reflex -> Workflow you may find all the actors
relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manu-
ally instantiated using Tools -> Instantiate Component. Fill in the “Class name” field with
org.eso.RecipeExecuter and in the pop-up window choose the required recipe from the pull-
down menu. To connect the ports of the actor, click on the source port, holding down the left mouse
button, and release the mouse button over the destination port. Please consult the Reflex User Manual
([3]) for more information.

• How can I broadcast a result to different subsequent actors? If the output port is a multi-port (filled
in white), then you may have several relations from the port. However, if the port is a single port (filled in
black), then you may use the black diamond from the toolbar. Make a relation from the output port to the
diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to
start a relation from the diamond itself. Please consult the Reflex User Manual ([3]) for more information.

• How can I manually run the recipes executed by Reflex? If a user wants to re-run a recipe on the
command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally
reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time
stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most
recent processing he/she should go to the latest directory and then execute the script cmdline.sh.
Alternatively, to use a customized esorex command the user can execute

ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
PATH_TO/esorex --recipe-config=<recipe>.rc <recipe> data.sof

where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute on the command line a recipe that used a specific raw frame, the way
to find the proper data.sof in the bookkeeping directory is via grep <raw_file> */data.sof.
Afterwards the procedure is the same as before.

If a recipe is re-executed with the command explained above, the products will appear in the directory
from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and
they will not be renamed. This does not happen if you use the cmdline.sh script.

• If I enter “-” into an empty integer parameter of an interactive window it is automaticaly completed
to “-1”. Why?

The parameters are validated for correctness according to their type (e.g. string, integer, float). In the
case of an integer or float parameter “-” alone is considered an invalid input and is therefore automatically
completed to “-1”. This is part of the validation of input done by the WxPython library.
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• Can I reuse the bookkeeping directory created by previous versions of the pipeline?

In general no. In principle, it could be reused if no major changes were made to the pipeline. How-
ever there are situations in which a previously created bookkeeping directory will cause problems due to
pipeline versions incompatibility. This is especially true if the parameters of the pipeline recipes have
changed. In that case, please remove the bookkeeping directory completely.
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13 Troubleshooting

Figure 13.1: TheDataOrganizer interactive window reports an error “:No DataSets have been created, check
the data set and the OCA rules.”.

1. I downloaded the data from the ESO archive, put them into a new directory, tried to run Reflex
on them, but

(a) it crashs
This may happen if one of the files was downloaded only partially (check for a file with the extension
fits.Z.part. You will have to download that file again in order to have an uncorrrupted file (and
remove the partial one).

(b) it fails with error message “:No DataSets have been created, check the data set and the OCA
rules.”(see Figure 13.1.)
This error may be due to the fact that the data provided by the ESO archive are compressed
(<filename>.fits.Z). Please remember to uncompress the data before executing Reflex.

(c) all DataSets are greyed out in the DataSets interactive window.
The ESO archive used with CalSelector does not always supply all static calibration files. As a
consequence some/all DataSets are greyed out because they were missing such required data.
Missing static calibration should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal.

2. The “Select DataSets” window displays my DataSets, but some/all of them are greyed out. What is
going on?

If a DataSet in the “Select DataSets” window is greyed out, then it means that the DataSet that was con-
structed is missing some key calibration(s) (i.e. the DataSet is incomplete). To find out what calibration(s)
are missing from a greyed out DataSet, click on the DataSet in question to highlight it in blue, and then
click on the button Inspect Highlighted . The “Select Frames” window that appears will report
the category of the calibration products that are missing (e.g. DARK). From this the user has then to de-
termine the missing raw data (in this case dark frames). If static calibrations are missing the mechanism
unfortunately does not work, but should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal
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3. The plots in the interactive windows does not allow me to properly inspect the products; how can I
change or measure what it is plotted?

The plots in the interactive window are meant to provide a general visualization of the product. However,
it is possible to inspect each file (input or output) with other visualization tools, or process them via
custom scripts to evalueta the quality.

At the bottom rigth corner of each interactive window, the list of inputs/outputs files is given. Select with
the mouse the file you would like to inspect and press Ctrl-C to copy its full path name.

It is also possible to change the general visualization tool in the Global Parameter section of the workflow,
by editing the FITS_VIEWER variable.

4. The workflow crashes with a message "...output file could not be moved...".

This is a memory allocation error during execution of the gravity_p2vm recipe due to insufficient memory
installed. Try exiting other application and rerun the recipe. If this fails, try to use gasgano to reduce the
P2VM. Unfortunately, this means that you have to use gasgano also for the rest of the data reduction of
the related science files.
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